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Danger!
Dangerous electrical voltage!
Before commencing the installation

• Disconnect the power supply of the device. 

• Ensure that devices cannot be accidentally retriggered

• Verify isolation from the supply

• Earth and short-circuit

• Cover or enclose neighbouring units that are live. 

• Follow the engineering instructions (AWA/IL) of the device 
concerned.

• Only suitably qualified personnel in accordance with EN 
50 110-1/-2 (VDE 0105 Part 100) may work on this device/
system.

• Before installation and before touching the device ensure 
that you are free of electrostatic charge. 

• The functional earth (FE) must be connected to the 
protective earth (PE) or to the potential equalizing. The 
system installer is responsible for implementing this 
connection.

• Connecting cables and signal lines should be installed so 
that inductive or capacitive interference do not impair the 
automation functions.

• Install automation devices and related operating elements 
in such a way that they are well protected against 
unintentional actuation.

• Suitable safety hardware and software measures should 
be implemented for the I/O interface so that a line or wire 
breakage on the signal side does not result in undefined 
states in the automation device.

• Ensure a reliable electrical isolation of the low voltage for 
the 24 V supply. Only use power supply units complying 
with IEC 60 364-4-41 (VDE 0100 Part 410) or HD 384.4.41 S2.

• Deviations of the mains voltage from the nominal value 
must not exceed the tolerance limits given in the technical 
data, otherwise this may cause malfunction and 
dangerous operation.

• Emergency switching off devices complying with IEC/EN 
60 204-1 must be effective in all operating modes of the 
automation devices. Unlatching the emergency switching 
off devices must not cause restart.

• Built-in devices for enclosures or cabinets must only be 
run and operated in an installed state, desk-top devices or 
portable devices only when the housing is closed.

• Measures should be taken to ensure the proper restart of 
programs interrupted after a voltage dip or failure. This 
should not cause dangerous operating states even for a 
short time. If necessary, emergency switching off devices 
should be implemented.

• Wherever faults in the automation system may cause 
damage to persons or property, external measures must 
be implemented to ensure a safe operating state in the 
event of a fault or malfunction (for example, by means of 
separate limit switches, mechanical interlocks, etc.).
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0 About this Manual

0.1 List of revisions
0 About this Manual

This manual describes the installation, commissioning and programming of 
the following SmartWire-DT gateway 

• EU5C-SWD-DP

The SmartWire-DT (SWD) communication system provides electromechani-
cal switchgear and pilot devices with communication capabilities. 

Support Center

The latest version of this manual can be found in other languages on the 
Internet by visiting our Support Center at:

http://www.moeller.net/en/support

By entering the search keyword "Gateway" or "SWD" into the quick search or 
by entering the document designation, e.g. MN05002002Z-DE. 
Basic information concerning the SmartWire-DT topic can be found in:

• "SmartWire-DT The System", MN05006002Z-EN
• "SmartWire-DT Modules", MN05006001Z-EN

You can find further information on the topics SmartWire-DT and the Smart-
Wire-DT modules in the following documents:

• Manual "XIOC signal modules", MN05002002Z-DE
• Instructional leaflet „EU5C-SWD…“, IL05006001Z-DE

The standard GSD files can also be found in our Support Center by entering 
"SWD" as a search term.

Download Center

The XSoft-CoDeSys-2 software described in this manual, as well as the 
SWD-Assist engineering tool, can be downloaded by visiting the 
Eaton Download Center at:

http://www.eaton-automation.com

0.1 List of revisions
This is a fully revised version. and replaces version
09/11 of MN05013002Z. In contrast to previous versions, which described 
SmartWire-DT gateways for various field buses, this version only covers one 
single SmartWire-DT gateway. The following table show the most important 
changes that have been made in terms of content: 

Publication date Page(s) Subject New Modi-
fied

Omit
ted

01/13 67 „"Online replacement" device parameter“ j
SmartWire-DT Gateway EU5C-SWD-DP 01/13 MN120001Z-EN www.eaton.eu 3
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0 About this Manual

0.2 Target group
0.2 Target group
This manual is intended for automation technicians and engineers.

Extensive knowledge of how to work with the field bus being used, as well 
as familiarity with the SmartWire-DT system, will make it easier to under-
stand the contents of this manual.

A specialist knowledge of electrical engineering is needed for commissioning 
and programming.

0.3 Exclusion of liability
All information in this operator manual was provided by us to the best of our 
knowledge and belief and in accordance with the current state-of-the-art. 
However, this does not exclude the possibility of inaccuracies so that we 
cannot accept any liability for the accuracy and completeness of the informa-
tion. In particular, this information does not guarantee any particular proper-
ties. 

The devices described here must only be set up and operated as specified in 
this manual and in the installation instructions provided with the device. The 
devices must be installed, commissioned, operated, maintained, and retrofit-
ted by qualified people only. The devices must only be used in the recom-
mended areas and only in conjunction with third-party devices and compo-
nents that have been approved by us. Only use is technically faultless 
condition is permitted. Fault-free and safe operation of the system requires 
proper transport, storage, installation and commissioning as well as careful 
operation and maintenance.If the following safety instructions are not 
observed, particularly with regard to commissioning and maintenance of the 
devices by insufficiently qualified personnel and/or in the event of improper 
use of the devices, any hazards caused by the devices cannot be excluded. 
We assume no liability for any injury or damages incurred.

0.4 Device designations and abbreviations
• GDS - device master data
Following designations XSoft-CoDeSys-2 are used:

• Module - SWD module
• Station - Coordinator
• Station address - Address of the field bus module 
4 SmartWire-DT Gateway EU5C-SWD-DP 01/13 MN120001Z-EN www.eaton.eu



0 About this Manual

0.5 Reading conventions
0.5 Reading conventions

Symbols used in this manual have the following meanings:

a

▶ Indicates instructions to be followed.

For greater clarity, the name of the current chapter and the name of the cur-
rent section are shown at the top of each page.

 DANGER

Warns of hazardous situations that result in serious injury or 
death.

 CAUTION 

Warns of the possibility of hazardous situations that could result 
in slight injury or even death.

NOTICE

Warns about the possibility of material damage.

￫ Indicates useful tips.
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0.5 Reading conventions
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1 SmartWire-DT Gateway® EU5C-SWD-DP

1.1 Proper use
1 SmartWire-DT Gateway® EU5C-SWD-DP

1.1 Proper use
 EU5C-SWD-DP SmartWire-DT gateways are used to establish a connection 
between a SmartWire-DT line, together with its SmartWire-DT modules, and 
a higher-level controller.

SmartWire-DT is not designed for transmitting safety-relevant signals and 
must not be used as a replacement for controllers such as burner, crane, and 
two-hand safety controllers.

Despite the above, SmartWire-DT can be used in applications with safety 
categories of up to 3, PL d as per EN ISO 13849-1 and SIL Cl2 as per 
EN 62061 if specific add-ons are incorporated. For more information, please 
consult manual "SmartWire-DT Modules", MN05006001Z-EN.

1.2 Overview of functions
EU5C-SWD-DP gateways are used to connect a SmartWire-DT line with 
PROFIBUS-DP and make it possible to access the data of up to 58 
SmartWire-DT modules . These gateways can be integrated as modular field 
bus modules into control systems that use this type of communications. This 
makes it possible to access the data of every individual module from the con-
troller.
 

Figure 1: Connecting the field bus and SmartWire-DT with a gateway

The integrated Ethernet switch on the device is used to connect  Standard 9-
pin D-sub socket  . The SmartWire-DT line, along with its modules, is con-
nected to the gateway. The ribbon cable, with the SWD modules and all con-
nection components - such as blade terminals and external device plugs - is 
referred to as the "SWD line."
SmartWire-DT Gateway EU5C-SWD-DP 01/13 MN120001Z-EN www.eaton.eu 7



1 SmartWire-DT Gateway® EU5C-SWD-DP

1.3 Versions
Terminals for two 24-V power supplies are available: POW for the gateway 
and the SmartWire-DT modules and AUX for powering the contactor coils if 
these are also operated via SmartWire-DT modules.

The 8-pin ribbon cable is used to run data communications, as well as the 
power for the SmartWire-DT modules and the contactor coils, from the gate-
way to the modules. 

The diagnostic port is used to connect to a computer in order to run the SWD 
assist planning and commissioning program.

When working with an EU5C-SWD-DP gateway, this interface can be used to 
update the operating system by using SWD assist.

1.3 Versions

a Power supply, 24 V DC POW

b Fieldbus interface

c Diagnostics interface

d Configuration buttons

e LED indicators: POW, DP, Config, SWD

f Power supply, 24 V DC AUX

g SmartWire-DT connection

h Dip switch for address setting

Figure 2: Front view 
EU5C-SWD-DP

f

g

e

d

c

b

a

h
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1 SmartWire-DT Gateway® EU5C-SWD-DP

1.4 Important data for engineering
1.4 Important data for engineering

In connection with the SmartWire-DT modules, the gateway appears as a 
modular module on the relevant field bus. The following gateway can be run 
on the field buses specified below: 

Each SmartWire-DT module is presented as a separate module, with its data, 
to the field bus master. 

The following number of SmartWire-DT modules is the maximum number 
that can be run on the gateway:

Make sure to take the maximum volume of data that can be transmitted on 
the field bus into account. The corresponding limit will be defined by the field 
bus.

The SmartWire-DT line may be extended up to 600 m.

1.4.1 Field bus connection
The connection to the gateway uses a 9-pin D-sub socket. A standard PROFI-
BUS plug, e.g., ZB4-209-DS2, is used to connect to the field bus. This plug 
features an integrated bus termination resistor that can be enabled and dis-
abled.

Figure 3: Pinout for the PROFIBUS-DP terminal socket on the gateway

Gateway Fieldbus

EU5C-SWD-DP PROFIBUS-DP

Gateway Maximum number of modules at the SWD line

EU5C-SWD-DP 58

Field bus-slave Max. input data [Byte] Max. output data [Byte]

PROFIBUS-DP 240 240

￫ Information about the volume of input and output data of an 
SWD module is provided in the Appendix of the manual "Smart-
Wire-DT Modules", MN05006001Z-EN.

PROFIBUS-DP SUB-D socket Signal

3 RxD/TxD-P

4 CNTR-P

5 DGND

6 VP (+5 V DC)

8 RxD/TxD-N

6

7

8

9

2

3

4

5

1
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1 SmartWire-DT Gateway® EU5C-SWD-DP

1.4 Important data for engineering
1.4.2 Baud rate
The gateway supports operation with the relevant field bus masters up to the 
following Baud rate: 

The unit will adapt to the field bus master's Baud rate automatically.

1.4.3 Valid device field bus addresses

Fieldbus Maximum data baud rate
in MBit/s

PROFIBUS-DP 12 

Data bus Address Address setting with 
dip switch

Valid address range

PROFIBUS-DP Slave address 2 - 8 1 - 125
10 SmartWire-DT Gateway EU5C-SWD-DP 01/13 MN120001Z-EN www.eaton.eu



2 Installation

2.1 Setting the gateway's field bus address
2 Installation

SWD gateways must only be installed and wired up by qualified electricians 
or other persons familiar with electrical engineering.

The SWD gateway is installed in the following order:

• Adjust the field bus adresse at the device.
• If the SWD gateway is the first or last module on the  PROFI-BUS-DP 

field bus, activate a bus termination resistor.
• Mount the device.
• Connect the power supply.
• Connect the SmartWire-DT line.
• Connect the field bus.

2.1 Setting the gateway's field bus address
Before mounting the device, set the field bus address by using the DIP 
switches (DIP = Dual Inline Package). The DIP switches are located under a 
cover on the right side of the gateway. 

, 

Follow the example below in order to configure an address  on the gateway - 
18 (decimal) is used as an example in this case:

18dec= 16 +2 = 1· 24 + 1 · 21 

The address is to be set at the dip switches.

for EU5C-SWD-DP the following applies:

▶ Use DIP switches 2–8 to set the PROFIBUS module 
address. For a list of valid addresses, refer to ￫ Section “1.4.3 Valid 
device field bus addresses”, page 10.

NOTICE

Changes made to the dip switches' settings will take effect only 
after the power supply is turned off and back on again.

DIP Switch

1 2 3 4 5 6 7 8 Description

27 26 25 24 23 22 21 20

OFF OFF OFF ON OFF OFF ON OFF Setting the gateway's field bus address 
to a value of 18dec
SmartWire-DT Gateway EU5C-SWD-DP 01/13 MN120001Z-EN www.eaton.eu 11



2 Installation

2.2 Activating the bus termination resistor for PROFIBUS-DP
Figure 4: Setting the field bus address on an EU5C-SWD-DP gateway

2.2 Activating the bus termination resistor for PROFIBUS-DP
If the EU5C-SWD-DP gateway is the first or last field bus module, a bus ter-
mination resistor must be connected externally. This resistor can either be a 
separate bus termination resistor or a special D-sub plug with an integrated 
bus termination resistor, e.g., ZB4-209-DS2. This plug has an integrated bus 
termination resistor that can be enabled and disabled.

2.3 Mounting Considerations
Install the EU5C-SWD-DP gateway in a control cabinet, a panelboard, or an 
enclosure in such a way that the power supply and terminal connections can-
not be touched accidentally during operation. Snap the device onto an IEC/
EN 60715 top-hat rail or fix it in place using fixing brackets. EU5C-SWD-DP 
gateways can be mounted either vertically or horizontally.

For ease of wiring, leave a clearance of at least 3 cm between the device ter-
minals and the wall or adjacent devices.

EU5C-SWD-DP 

Example: Address 18dec

OFF

ON

2 3 4 5 6 7 81

1
2
4
8
16
32
64

OFF

ON 2 3 4 5 6 7 81

Figure 5: Vertical mounting Figure 6: Horizontal mounting 

3
0

 m
m

(1
.1

8”
)

3
0

 m
m

(1
.1

8”
)

30 mm

(1.18”)

30 mm

(1.18”)
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2 Installation

2.3 Mounting Considerations
2.3.1 Mounting the EU5C-SWD-DP gateway on a top-hat rail
Before mounting the device, make sure that you have set the device's field 
bus address and, if necessary, that the bus termination resistor (if any) has 
been activated with the corresponding DIP switch.

Figure 7: Mounting on top-hat rail

▶ Place the EU5C-SWD-DP gateway on the top-hat rail's upper edge in an 
inclined position. Lightly push the device down and against the top-hat 
rail until it snaps into place over the top-hat rail's lower edge.

The spring mechanism will make the EU5C-SWD-DP gateway automatically 
lock into place.

▶ Check that the gateway is seated firmly.

The device is mounted vertically on a top-hat rail in the same way.

2.3.2 Screwing the EU5C-SWD-DP gateway into place
For screw fixing, you will need two fixing brackets that can be used on the 
back of the EU5C-SWD-DP gateway. Fixing brackets ZB4-101-GF1 are avail-
able as accessories.

1

2

3

4

Figure 8: Inserting a fastening 
bracket

Figure 9: EU5C-SWD-DP screw fixing

CLIC
K !

M4
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2 Installation

2.4 Potential Relationship between the Components
2.4 Potential Relationship between the Components
The entire SmartWire-DT system operates on a common supply voltage. Pro-
vide a common star point for the earth wiring. In this way the various mod-
ules in the SmartWire-DT system will not be electrically isolated from one 
another. The field bus and the SmartWire-DT system are electrically isolated 
from one another.
14 SmartWire-DT Gateway EU5C-SWD-DP 01/13 MN120001Z-EN www.eaton.eu



2 Installation

2.5 Connecting the power supply
2.5 Connecting the power supply

The gateway and the SmartWire-DT modules are powered via the POW ter-
minals. The Gateway uses the voltage at POW to generate the 15-V supply 
voltage for the SmartWire-DT modules with a maximum output current of 
0.7 A.

If loads or contactor modules are also connected via the SWD line, the 24-
VDC control voltage for the loads must be supplied in addition to the device 
supply voltage. The AUX terminals are used for this purpose.

Take into account the total power consumption and the voltage drop in your 
SWD line and, if necessary, include additional supply units, such as power 
feeder modules, in your design. The SWD assist software program will pro-
vide support when you are carrying out the corresponding calculations. In 
addition, it will automatically let you know if additional power supply modules 
are required for your design.
The manual "SmartWire-DT The System", MN05006002Z-EN, contains 
detailed calculation examples.

Figure 10: Connection of power supply

 DANGER

In safety-relevant applications the power supply providing 
power to the SmartWire-DT system must feature a PELV power 
supply unit (protective extra low voltage).

 DANGER

The gateway has protection against polarity reversal for the 24-
V-DC-POW supply. If, however, the gateway is connected to a 
grounded device, e.g., a computer, via the diagnostic interface, 
the gateway may be destroyed if the polarity of the power sup-
ply is reversed!

24V
0V

AUX

24 V DC

0 V

POW

24V
0V

F1 F2
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2 Installation

2.5 Connecting the power supply
▶ Connect the 24 V DC voltage to the connection terminals POW on the 
front side of the gateway.

▶ If necessary, connect the 24 VDC voltage for the contactor coils to the 
AUX terminals.

▶ Connect the POW and AUX supply voltages via separate miniature cir-
cuit-breakers or fuses.

Miniature circuit-breaker F1 for POW

• Cable protection in accordance with DIN VDE 0641 Part 11, IEC/
EN 60898:
• Miniature circuit-breaker 24 V DC rated operational current 3 A;

trip type C or
• Fuse 3 A, utilization class gL/gG

• Cable protection for cable AWG 24 in accordance with UL 508 and CSA-
22.2 no. 14:
• Miniature circuit-breaker 24 V DC rated operational current 3 A;

trip type C or
• Fuse 3 A

Miniature circuit-breaker F2 for AUX

• Cable protection in accordance with DIN VDE 0641 Part 11, IEC/
EN 60898:
• Miniature circuit-breaker 24 V DC rated operational current 3 A;

trip type Z or
• Fuse 3 A, utilization class gL/gG

• Cable protection for cable AWG 24 in accordance with UL 508 and CSA-
22.2 no. 14:
• Miniature circuit-breaker 24 V DC rated operational current 2 A;

trip type B or
• Fuse 2 A
16 SmartWire-DT Gateway EU5C-SWD-DP 01/13 MN120001Z-EN www.eaton.eu



2 Installation

2.6 Connect SmartWire-DT®
2.6 Connect SmartWire-DT®

▶ Grab the end of the SWD line that has an arrow pointing away from the 
blade terminal. 

▶ Plug this blade terminal into the gateway's SmartWire-DT connection.

To do so use the SmartWire-DT cable SWD-4-100LF8-24 and the SWD-4-
8MF2 relevant blade terminal or prefabricated cables of type SWD-4-(3/5/
10)F8-24-2S.

Figure 11: Connection SmartWire-DT

￫ Detailed instructions explaining how to assemble a SmartWire-
DT external device plug (SWD4-8SF2-5) onto an 8-pin Smart-
Wire-DT cable can be found in "SmartWire-DT The System", 
MN05006002Z-EN, in the "Assembling external device plug 
SWD4-8SF2-5" section.

SWD4-…LF…

SWD4-8MF
SmartWire-DT Gateway EU5C-SWD-DP 01/13 MN120001Z-EN www.eaton.eu 17



2 Installation

2.7 Connect field bus
2.7 Connect field bus

PROFIBUS-DP 

To attach the PROFIBUS-DP cable, a special PROFIBUS-DP plug (e.g. ZB4-
209-DS2) is needed. This has the necessary wiring for fault-free operation at 
up to 12 Mbit/sec.

▶ Connect the PROFIBUS-DP cable with the PROFIBUS-DP plug to the 
gateway's field bus interface.

Figure 12: EtherNet/IP or Modbus-TCP
PROFIBUS-DP

off

on
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2 Installation

2.8 Connecting the diagnostics interface
2.8 Connecting the diagnostics interface

The EU5C-SWD-DP SmartWire-DT gateway features a serial interface on the 
front. By using a programming cable, you can connect it to a computer and 
do the following with the corresponding software:

• Online SmartWire-DT line diagnostics using the SWD assist program
• Generate and export a project-specific GSD file.
• Updating the operating system.

You can use any of the following programming cables:

Table 1: Programming cable for the connection to a PC

Figure 13: Configuration of the serial interface.

Device Programming cable Baud rate

EU5C-SWD-DP EU4A-RJ45-CAB1 –

EU4A-RJ45-USB-CAB1 38.4 kBaud

Pin RS232

8 8 RxD

7 7 –

6 6 –

5 5 TxD

4 4 GND

3 3 –

2 2 –

1 1 –
SmartWire-DT Gateway EU5C-SWD-DP 01/13 MN120001Z-EN www.eaton.eu 19



2 Installation

2.9 Wiring in accordance with EMC requirements
2.9 Wiring in accordance with EMC requirements

Undesired faults can occur on the field bus due to electromagnetic interfer-
ence. This can be minimized beforehand by the implementation of suitable 
EMC measures. These include:

• EMC-conformant system configuration,
• EMC compliant cable routing,
• Measures designed to reduce potential differences
• the correct installation of the field bus system

(cable, connection of the bus connectors, etc.),
• Using shielding

Figure 14: Field bus shielded by using a shield

for top-hat rail for mounting plate

M4

ZB4-102-KS1

ZB4-102-KS1

FM 4/TS 35
(Weidmüller)

KLBü 3-8 SC
(Weidmüller)
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3 Commissioning

3.1 Putting the SmartWire-DT® into operation
3 Commissioning

Before switching on, check whether the power supply for the gateway is 
connected correctly. The configuration and installation of the SmartWire-DT 
line must also have been carried out correctly with all modules connected.

Commissioning takes place in several steps:

1 Commissioning the SmartWire-DT line
2 Take the field bus into operation.
3 Load and start the PLC program.

Rules for successfully commissioning an EU5C-DP

Make sure to follow the rules below in order to successfully commission the 
gateway:

To operate the device, the target configuration must be stored. The device 
will only startup up error-free if the actual configuration at the start matches 
the target configuration.

3.1 Putting the SmartWire-DT® into operation
￫ Chapter 7 "What you need to know about SmartWire-DT®“, page 57 goes 
over the terms and basic knowledge related to SmartWire-DT.

Before the gateway can exchange data with the PLC, the target configuration 
needs to be imported and stored in the gateway. The target configuration will 
be compared with the current actual configuration every time the gateway is 
started. During this process, the gateway will determine whether there are 
any SWD modules that cannot be reached or whether a wrong type of mod-
ule is plugged into the SWD line. SmartWire-DT's response to any detected 
discrepancies will depend on how the device parameters for the SWD coor-
dinator and the SWD modules have been configured ￫ Chapter 7 "What 
you need to know about SmartWire-DT®“, page 57. 

 DANGER

If you already have integrated devices and equipment in a sys-
tem, block off any parts of the system that are connected to the 
working area in order to prevent access. This will ensure that no 
one will be injured if the system behaves unexpectedly, e.g., 
motors start up unexpectedly. 

 DANGER

Switch off the power supply whenever you are reconnecting 
modules in the SmartWire-DT system.  The SmartWire-DT mod-
ules may be permanently ruined otherwise!
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3 Commissioning

3.1 Putting the SmartWire-DT® into operation
If a SmartWire-DT module drops out, it will be possible to continue running 
the SmartWire-DT line with the remaining modules. This applies even after 
the gateway is restarted or switched on again later. Please note that the 
application program can always be used to diagnose cases in which a SWD 
module has dropped out.

Import the target configuration in the following cases:

• Initial Commissioning
• Replacement of a defective module
• Whenever the SWD module layout on the SWD line is changed

The online functions of the SWD assist software offer a wide range of 
options for the display and the diagnostics functions of the SmartWire-DT 
line even without the active PLC ￫ Section “7.8 SWD assist”, page 74.

3.1.1 Reading of target configuration
The target configuration needs to be imported the first time the device is 
commissioned, whenever a module is replaced, and whenever the SWD 
module layout on the SWD line is changed.

Requirements that must be met in order to import the target configuration:

• All SmartWire-DT modules are connected to the SmartWire-DT line.
• The SmartWire-DT line is connected to the gateway.
• Voltage POW is applied to the gateway and the POW LED lights up.
• Configurated power feeder module are connected.
• The SmartWire-DT status LEDs of the SWD modules are on or are flash-

ing.

▶ Press the configuration button on the gateway for at least two seconds. 
The SWD-LED on the gateway begins to flash orange. The SWD-LEDs 
on the SmartWire-DT modules also flash.

All modules are addressed in sequence, the complete configuration is stored 
retentively in the gateway as target configuration. After this the SWD-LED 
lights green, continuous light.

￫ The target configuration should only be imported for SWD lines 
that have all the corresponding SmartWire-DT modules.

NOTICE

If you press the configuration button and a SWD module is 
missing or has dropped out from the SWD line, only the mod-
ules up to the device that dropped out will be assigned an 
address and stored. It will not be possible to use the remaining 
modules until the defective module is replaced and the configu-
ration is imported again by pressing the configuration button.
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3 Commissioning

3.2 Take the field bus into operation
3.1.2 Switching on when the target configuration is stored
If a target configuration is already stored in the gateway, the system will 
check, every time the gateway is switched on, whether the modules that are 
actually on the SWD line match the target configuration in the gateway. The 
SWD LED on the gateway will indicate the result of this check ￫ Section 
“7.7 LEDs on the device”, page 73.

3.2 Take the field bus into operation
If you are putting the field bus into operation for the first time, you will first 
have to set up the PLC programming environment ￫ Chapter 5 "Take XSoft-
CoDeSys-2 into operation“, page 31  

 Generally speaking, the following basic initial commissioning steps need to 
be carried out:

1 Add project-specific or standard GSD files to the PLC programming envi-
ronment.

2 Open or create the project in the PLC programming environment.
3 Search for the field bus master in the PLC programming environment 

(target system) and Set the baud rate, e.g.,1.5 Mbaud.
4 Select the gateway as a field bus module.
5 If you are using the  standard GSD file, select the SmartWire-DT
6 Configure the gateway's and the SWD modules' parameters in the PLC 

programming environment

￫ If the target configuration import process cannot be started and 
the SWD LED is showing an orange light, disconnect the Smart-
Wire-DT gateway's field bus connection and try importing the 
target configuration again.

￫ If the SWD LED shows a solid red light, no addresses have 
been assigned to any of the SWD modules. If this happens, 
check the SWD line - especially the SmartWire-DT connection.
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3 Commissioning

3.2 Take the field bus into operation
3.2.1 Creating PROFIBUS-DP field bus communication
The green SWD LED on the gateway is used to indicate that the gateway 
and the SmartWire-DT line are communicating successfully. This is a prereq-
uisite for communications between the gateway and the PLC via the field 
bus.

▶ Load the program into the PLC.

The PROFIBUS field bus' configuration will be transferred to the PROFIBUS 
master when the program is loaded into the PLC. Once this is done, the 
PROFIBUS master will transfer the planned SWD configuration for the 
SmartWire-DT line to the gateway and check it. If the planned SWD configu-
ration matches the target configuration stored in the gateway, the Config 
LED will show a solid green light. The DP LED and the Config LED will be 
used to indicate any errors that occur￫ Section “Table 9: LED SWD coordi-
nator”, page 73.

If all status displays indicate a green continuous light, commissioning has 
been completed successfully. 

3.2.2 DP-LED status display

Table 2: DP-LED at SWD coordinator

Description DP-LED Data exchange 
Gateway - PLC

Cyclic data communication runs on the 
PROFIBUS. 
Defined planned SWD configuration = target 
configuration.

Green continuous light yes

Defined planned SWD configuration ≠ target 
configuration

The DP master does not detect a data inter-
change.

Flashing (green) yes

No communication takes place on the 
PROFIBUS. No DP master is detected (for 
example, on account of a wrong module 
address).

off No

Extended DP diagnostics:
The input data from SmartWire-DT modules is 
invalid or the necessary modules are missing.

Orange yes

The gateway is in firmware update mode when 
the POW LED is off. The firmware mode can be 
left by switching on the supply voltage again. 
The firmware update mode can be left by 
switching on the supply voltage again.

Changes from continuous 
orange light to red

No
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3 Commissioning

3.2 Take the field bus into operation
3.2.3 POW status display

Description POW

Device ready for operation on

If the other three gateway LEDs are permanently red, the operating system or the 
hardware is faulty.
If they show continuous orange light, the gateway is in Firmware Update mode. 
This mode can be deactivated by switching on the power supply again.

off
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3.2 Take the field bus into operation
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4 Description files for PROFIBUS-DP

 

4 Description files for PROFIBUS-DP 

In order to be able to run the SWD gateway on a PROFIBUS-DP, the SWD 
gateway's properties must be stored in a description file. This file follows 
specific standards for the corresponding field bus and can be loaded into the 
PLC programming environment for the field bus master being used.

The GSD file contains all the properties of a SWD gateway in its role as a 
field bus module. Since SWD gateways are modular field bus modules, this 
GSD file will also contain the properties of the potential SWD modules as 
inputs/outputs.

This is why new developments in SmartWire-DT, as well as the addition of 
new SWD modules, will result in new and different versions of gateway GSD 
files.

Make sure that you are working with the latest version of the standard GSD 
files in your PLC programming environment. Check whether there are avail-
able updates for the files at our Support Center ￫ Page 3.

The selected GSD file must be appropriate for the SWD modules that you 
will be running with SmartWire-DT. In turn, this will also require you to use a 
specific operating system version, as well as a specific hardware device ver-
sion.

For PROFIBUS-DP, make sure to use the latest GSD standard file and the lat-
est operating system version.

Updating the operating system

For more information on how to update the operating system, please refer to 
the Online Help function included in SWD-Assist version 1.10 and higher. 
Enter "Update operating system" under the "Search" tab.

In the case of EU5C-SWD-DP, the versions are updated via the diagnostic 
interface by using SWD-Assist.

￫ Please note that not all GSD files support all SmartWire-DT 
modules.
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4.1 Where are the standard files?
4.1 Where are the standard  files?

For the PROFIBUS-DP gateway, there are two different standard GSD files 
available in order to make it possible to run the gateway with different types 
of field bus masters. Accordingly, you will get the latest available language-
specific GSD files for:

• Motorola based CPU (e.g.  Siemens S7)
• Moel4dxx.gsd (English) 
• Moel4dxx.gsf (French) 
• Moel4dxx.gsg (German) 
• Moel4dxx.gsi (Italian) 
• Moel4dxx.gss (Spanish) 
• the appropriate figures KM4D13_D.bmp and KM4D13_N.bmp

• Intel-based CPUs (e.g.  Eaton XC100/200)
• Moe4dxx.gsd (English)
• the corresponding KM4D14_N.bmp figure

where xx = GSD file version. Files with xx = "13" correspond to the Profibus 
V0 Specification, while files with xx= "14" correspond to the Profibus V1 
Specification.

To download the standard GSD file, please visit our Support Center 
￫ Page 3. To find it quickly, simply enter "SWD" or "GSD" as a search term.

▶ Click on "Download" to the left of "GSD file for ... Motorola ..." 
or "GSD file for ... Intel ..." .

▶ Select the latest version, save it, and unzip the .zip file in a project folder 
of your choice.

4.2 What is a project-specific GSD file
Instead of using a standard GSD file, you can also use SWD assist to gener-
ate a project-specific GSD file and use it in the PLC programming environ-
ment the same way you would a standard GSD file. The selection of SWD 
modules on the SWD line will already be assigned to the EU5C-SWD modu-
lar field bus module.

If you load the project-specific GSD file into the PLC programming environ-
ment, the SWD modules will be shown directly under "Selected Modules," 
eliminating the need to select each individual SWD module 
manually￫ Section “5.4 Select the SmartWire-DT® modules”, page 33. In 
addition, this will prevent you from selecting the wrong SWD modules by 
accident.

Follow the steps below in order to generate a project-specific GSD file:

▶ Start SWD assist.
▶ Switch to the Communication view by clicking on the 

"View" -> "Communication View" menu option.
▶ Click the "Online" button.

The program will show the target configuration, but this configuration will not 
be in the Project view yet.
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4.3 Versions of description files
▶ Click on the "Device =>PC" button.

The target configuration will be loaded into the Project view.

▶ Click on the “Offline” button.
▶ Switch to the Project view by clicking on the "View" -> "Communication 

View" menu option. 
▶ Click on the menu option "Project"->"save GSD file".
▶ Specify the project folder as the storage location and confirm with 

"Save."

SWD assist stores the GSD file under the name of the current project with 
the appropriate extension, such as "SWD_Proj.gsd" for EU5C-SWD-DP. This 
can be installed in XSoft-CoDeSys-2 in the same way as the standard GSD 
file.

4.3 Versions of description files
To download an overview table showing which description file has to be 
used in order to be able to add your SWD modules to your PLC configuration, 
please visit our Support Center ￫ Section “ Support Center”, page 3 and 
enter "SWD" into the Search field.

The "SmartWire-DT Modules" manual defines the applicable device version, 
operating system version, and description file version requirements for each 
SWD module in detail.

￫ Give the GSD file a name with a maximum of eight characters. 
Certain PLC programming environments, such as the "HW Con-
fig" PLC programming environment, will only recognize names 
of up to eight characters.
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4.3 Versions of description files
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5 Take XSoft-CoDeSys-2 into operation

5.1 Installing the GSD file in XSoft-CoDeSys-2
5 Take XSoft-CoDeSys-2 into operation

The connection of a SWD line via the SWD gateway EU5C-SWD-DP to the 
controller XC200 is described in this chapter. 

Please check beforehand whether you have a current XSoft-CoDeSys-2 ver-
sion installed with the necessary GSD files.

Please note the list of abbreviations, as the XSoft-CoDeSys-2 PLC program-
ming environment uses different designations from those used in this man-
ual in certain cases

5.1 Installing the GSD file in XSoft-CoDeSys-2
We recommend working with the project-specific GSD file, as it already 
includes the assignments between the modular EU5C-SWD-DP field bus 
module and the SWD modules on the SWD line in order to make your work 
easier.

Likewise you can use the standard GSD file 

▶ Copy the standard GSD file or the project-specific GSD file to the folder 
intended for storing the standard GSD file.
In the case of the XSoft-CoDeSys-2 Eaton programming system, this 
folder will be found on your computer under:

C:\Program Files\Common Files\CAA-Targets\<Version>\PLCConf

where <Version> is the installed configurator version e.g., 
"Moeller V2.3.9."
After doing this, you will be able to use the project-specific GSD file just 
as you would the standard GSD file.

▶ Start the XSoft-CoDeSys-2.
▶ Install the GSD files in XSoft-CoDeSys-2 with the

"Tools" -> "Select configuration file" menu option.
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5.2 Select field bus master
5.2 Select field bus master

Then please proceed as follows:

▶ Start XSoft-CoDeSys-2 and open a project.
▶ Open the "Controller configuration" in the "Resources" tab and select the 

Profibus bus master module XIOC-NET-DP-M. This must be positioned 
on the first three slots.

Figure 15: Selection of the DP master in XSoft-CoDeSys-2 

5.3 Select gateway as field bus module
▶ Select the field bus master and use the "Insert" -> "Attach subelement" 

menu option to open the selection list of field bus modules.
▶ Select the GSD file „EU5C-SWD-DP V1 (Int) (Moe4d14.gsd“.
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5 Take XSoft-CoDeSys-2 into operation

5.4 Select the SmartWire-DT® modules
Figure 16: Select the gateway in XSoft-CoDeSys-2

5.4 Select the SmartWire-DT® modules
If you are using the project-specific GSD file, this step is not necessary. Skip 
to ￫ Section “5.5 Change the device parameter of the gateway”, page 34.

If you are using the standard GSD file, select the SWD modules as follows:

▶ Change over to the register "Inputs/Outputs".
▶ Now select the SWD modules that you need for the SWD line. 

Make sure to select them in the right order. The order of the SWD mod-
ules in "Selected modules" must match their physical order on the SWD 
line that is ready for operation. Within this context, the "first" SWD mod-
ule is the one right after the gateway.
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5.5 Change the device parameter of the gateway
Figure 17: Selection of the modules in XSoft-CoDeSys-2

If you cannot find a specific SWD module under the "Inputs/Outputs" tab, the 
standard GSD file you are using may be obsolete. If this is the case, down-
load the latest version of the standard GSD file from the Eaton Support Cen-
ter ￫ Page 3.

5.5 Change the device parameter of the gateway
The XSoft-CoDeSys-2 programming environment is also used to configure 
parameters for the communications between the gateway and the field bus 
master and the gateway and the SWD line, as well as the device parameters 
for the SWD modules and the EU5C-SWD coordinator.

These are the meanings of the individual registers.

“Base parameters” register

Here you can define the I/O start addresses for the mapping of the SWD 
modules onto the inputs and outputs of the controller map. As standard the 
PLC programming tool creates complete connection to the I/Os up to now. 
You can, however, change these values to other, unassigned areas.

“DP parameter” tab

The parameters that relate to communication with the field bus PROFIBUS-
DP are entered under these settings. These include, for example, the 
address of the EU5C-SWD ("Module addresses" in XSoft-CoDeSys-2) field 
bus module and the monitoring time for the field bus' cyclic data communica-
tions (watchdog control).
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5.6 Change the device parameter of the SWD module
Figure 18: Adjusting the DP parameters in XSoft-CoDeSys-2

“User parameters” tab

This is where the device parameters for the EU5C-SWD coordinator are con-
figured Table 7, page 68. In order to configure the "Online Replacement" 
device parameter, for example, follow the steps below:

▶ Open the "User parameters" tab in the XSoft-CoDeSys-2 PLC Configura-
tion window.

▶ Click on the SWD coordinator's "Online Replacement" device parameter.
.

Figure 19: Device parameter of the SWD coordinator in XSoft-CoDeSys-2

5.6 Change the device parameter of the SWD module
You can parameterize the startup behavior for each SWD module. By doing 
this you define how the gateway reacts, if a module is not available. The 
default setting is that all modules have to be available. However, the informa-
tion as to whether a module is available is also reported to the application via 
the diagnosis so that the failure of a module can be reacted to individually 
here 
￫ Section “6.8 Diagnostics”, page 52.
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5.6 Change the device parameter of the SWD module
For an explanation of the SWD modules' device parameters, please refer to 
Table 8, page 69.

The parameter configuration here will only make sense if the SWD configura-
tor's "All Slaves optional" parameter is set to "Defined for each slave."

In order to change the device parameter's setting, follow the steps below:

▶ Select the corresponding SWD module in the "Inputs/Outputs" tab in the 
table “Selected modules”.

▶ Click on the “Properties” button. The dialog field "Module properties" 
relating to the selected SWD module is displayed. 

▶ Double-click on "Device shall be present" in the "Value" column. 
The setting will change to "Device may not be present."

Figure 20: Parameterizing SWD modules in XSoft-CoDeSys-2

You can also define in this dialog whether the SWD module can be replaced 
by a universal module M22-SWD-NOP(C). In this case set the device parame-
ter of the SWD module "Replacement by universal module“ to "allowed“.

For information regarding the SWD universal module, please consult the 
manual "SmartWire-DT Modules", MN05006001Z-EN.
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5.7 Cyclic data communication via input/output addresses
5.7 Cyclic data communication via input/output addresses

When the SWD modules are configured in the XSoft-CoDeSys-2 PLC pro-
gramming environment, the modules' input/output addresses are assigned 
automatically. The addresses assigned to the individual SmartWire-DT mod-
ules can be seen in the PLC programming environment.

Figure 21: SWD module addresses is XSoft-CoDeSys-2

These inputs and outputs can be addressed using the PLC's I/O image table.

￫ Please refer to the manual "SmartWire-DT Modules", 
MN05006001Z-EN, "Module properties" for the exact configura-
tion and meaning of the input and output data.
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5.8 Acyclic data communication
5.8 Acyclic data communication

SWD modules such as the PKE-SWD-32 module for the electronic motor-
protective circuit-breaker also supply acyclical data in addition to the cyclical 
data. Function blocks from the xSysNetDPMV1.lib library are used with 
XC100/200 controllers for reading and writing acyclical data. This library was 
also installed with XSoft-CoDeSys-2 and is for example to be found in the 
library list for XC200:

C:\Program Files (x86)\Common Files\CAA-Targets\Eaton Automation\V2.3.9 
SP3\Lib_XC-201.

The library contains the following blocks for acyclic data communications:

 XDPMV1_READ,

 XDPMV1_WRITE.

Figure 22: Prototype for the function block XDPMV1_READ

Figure 23: Prototype for the function block XDPMV1_WRITE

Important information concerning designations

SWD module data that is read and/or written acyclically will hereafter be 
referred to as "DP-V1 objects.". The number and meaning of the available DP-
V1 objects are described in the relevant documentation (e.g. "SmartWire-DT 
Modules", MN05006001Z-EN).

The address of a DP-V1 object is defined by the slot number (uiSlot), the 
index (uiIndex) and the read/write data length.

The slot number corresponds to the SWD module's address. In other words, 
the first module will have slot number 1, the second module will have slot 
number 2, etc. Meanwhile, the index is used to define the address for the 
DP-V1 object. Just as with the slot, the first object will be assigned number 
1, the second object will be assigned number 2, etc. In the case of the 
PKE-SWD-32 SmartWire-DT module, DP-V1 object 1 will deliver current Irel.

XDPMV1_READ

BOOL xEnable uiResponseLen UINT

UINT uiDevice xReady BOOL
UINT uiStationAddr typState UINT

UINT uiSlot uiError UINT

UINT uiIndex

UINT uiLenToRead

DWORD dwBuffer

XDPMV1_WRITE

BOOL xEnable xReady BOOL

UINT uiDevice typState UINT

UINT uiStationAddr uiError UINT

UINT uiSlot

UINT uiIndex
UINT uiLenToWrite

DWORD dwBuffer
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5.8 Acyclic data communication
Please observe the following guidelines when using these function blocks:

• Do not access these blocks cyclically as it will unnecessarily load cyclic 
bus operation.

• Program a maximum of one block to read and one block to write for each 
master.

• Interlock the read and write blocks so that only one block can be active 
at a time!

The modules must therefore be accessed consecutively via the function 
blocks. DP-V1 objects of a module must also be processed  consecutively.

General handling guidelines for the modules

▶ To start a job, apply a "1" signal (rising edge) at the "Enable" input. After 
the job is complete the “Ready” output will be set to the “1” state.

▶ Evaluate then the “typState” output. If the output value is 3 (job properly 
processed), the job was correct completed. If the output value is "4", this 
indicates an incorrectly completed job. In this case, evaluate the “uiEr-
ror” output.
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5.8 Acyclic data communication
What do the block parameters mean?

Failure code at "uiError" output

Table 3: Failure codes at "uiError" output

Operand Meaning

xEnable Start 

uiDevice Device number (see table below)

uiStationAddr PROFIBUS-slave-address of the SWD-Gateway

uiSlot SWD module address (value range 1 to 58)

uiIndex Object Index

uiLenToRead Length of read data in bytes (value range 0 to 240). If the read data length is 
unknown, enter the maximum value of “240”. The actual read byte length is indi-
cated by the “uiResponseLen” output.

uiLenToWrite Length of write data in bytes
(value range 0 to 240)
If an error message appears if you do not enter the exact value.

dwBuffer Address to a buffer

uiResponseLen Length of data actually read (bytes)

xReady Job process state

typState State of module

0: not being processed
1: invalid parameter
2: started
3: job successfully completed
4: job ended with an error – check the failure code on the "uiError" output

uiError Failure code see Tabelle 3 ("Failure code")

Failure code Meaning

2 No resources for job processing are available in the SWD gateway (internal fault)

3 The master has not activated the DP-V1 mode for this SWD gateway.
Check the PLC configuration!

9 invalid response (internal fault)

17 No response from this SWD gateway. Possible causes:
• uiStationAddr entry incorrect
• SWD gateway or field bus not active

18 General bus fault
• Check bus cables
• Check master
• Check the DP address or high station address of other masters in the PLC configuration

25 unintelligible response, SWD module is not compliant with the DP-V1 standard

54 incorrect answer

129 DP-V1 communication has not been configured and activated or the PROFIBUS module 
address does not exist.

130 DP-V1 communication has been blocked, PROFIBUS module is incorrect.
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5.8 Acyclic data communication
Function block assignment (Device number)

Using an XC200 PLC makes it possible to use up to three DP modules 
XIOC-NET-DP-M. Each DP module can use one block for acyclic read opera-
tions and one function block for acyclic write operations. In other words, a 
maximum total of six function blocks can be used in the user program. Using 
device numbers will allow you to determine which function block is assigned 
to which DP module. These device numbers depend on the corresponding 
DP module's slot (see Tabelle 4). When using an XC100 PLC, the device 
number is generally “0,” since only one single DP module can be used in this 
case.

Table 4: Device number for XC200

131 A job is still active (internal FB error).

132 Parameter and data fault (internal fault)

133 Parameter fault: possible causes: "uiStationAddr", "uiSlot" or "uiIndex" are incorrect.

XI/OC slot 1 2 3 Notes

Card DP-M DP-M DP-M Configuration is valid

Device No. 0 1 2

Card DP-M DP-M X-module1) Configuration is valid

Device No. 0 1 –

Card X-module1) DP-M DP-M Configuration is valid

Device No. – 0 1

Card DP-M X-module1) DP-M Configuration fault: DP modules have to be 
placed next to each other

Device No. 0 – 2

Card X-module1) X-module1) DP-M Configuration is valid

Device No. – – 0

1) X module: Module may be any XIOC module.

Failure code Meaning
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6.1 Install the GSD files in STEP 7
6 Take STEP 7 into operation

This section describes how to connect an SWD line to a SIMATIC S7-300/
400 controller via an EU5C-SWD-DP gateway.

6.1 Install the GSD files in STEP 7
You can either install the standard GSD file or a project-specific GSD file 
￫ Chapter 4 "Description files for PROFIBUS-DP“, page 27. To install the 
GSD files, follow the steps below:

▶ Open the "HW Config" programming environment and check whether 
the SWD gateway is found in the following window:"
Hardware Catalog," 
"PROFIBUS DP" -> 
"Additional FIELD DEVICES" -> 
"Switching devices" folder or, if using a project-specific GSD file, the -> 
"SWD assist" subfolder

▶ In STEP 7 install all GSD files via the menu option
"Tools" -> "Install GSD files...."

Figure 24: Starting the installation of the GSD file in HW config;
Screenshot of a STEP 7 with courtesy from SIEMENS, Nürnberg

▶ In the dialog that opens choose the option "from the directory " from the 
"Install GSD files" list and select the appropriate directory.

▶ Choose the required GSD file and click the "Install" button.

Figure 25: Installation of the GSD file - Selection in the HW config
Screenshot of a STEP 7 with courtesy from SIEMENS, Nürnberg
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6.2 Select gateway as field bus module
The SWD gateway will be installed and shown in the following window:

• "Hardware catalog," 
"PROFIBUS-DP"-> 
"Additional FIELD DEVICES" ->
"Switching devices" -> 
or the "SWD assist" subfolder

The SWD gateway will be shown in this window with the following designa-
tion 

• "EU5C-SWD-DP (Mot)" if installed with a standard GSD file 
• "EU5C-SWD-DP (<SWD assist>)" if installed with a project-specific GSD 

file

The EU5C-SWD-DP gateway can now be configured.

6.2 Select gateway as field bus module
The following description applies regardless of whether the standard GSD 
file or a project-specific GSD file is being used.

Prerequisite: The "HW Konfig" PLC programming environment must be run-
ning.

￫ If an older GSD file is already present, this is moved to the 
backup directory before the installation.
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6.2 Select gateway as field bus module
6.2.1 Configuration with standard GSD file installed
 

Figure 26: Configuration with standard GSD file installed in HW config
Screenshot of a STEP 7 with courtesy from SIEMENS, Nürnberg

▶ Now add the SWD gateway with the component designation "EU5C-
SWD-DP (Mot)" to the PROFIBUS line in the window for the station.
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6.3 Select the SmartWire-DT® modules
6.2.2 Configuration with project-specific GSD file installed

Figure 27: Configuration with project-specific GSD file installed in HW config
Screenshot of a STEP 7 with courtesy from SIEMENS, Nürnberg

▶ Add the SWD gateway with the component designation "EU5C-SWD-
DP" (<SWD assist project name>) to the PROFIBUS line in the station 
window.

The next step, ￫ Section "6.3 Select the SmartWire-DT® modules“, is 
unnecessary in this case.

If you want to add additional SWD modules to a project-specific PROFIBUS-
DP configuration with the "HW Konfig" PLC programming environment, fol-
low the steps in the description below, ￫ Section "6.3 Select the Smart-
Wire-DT® modules“.

6.3 Select the SmartWire-DT® modules
If you want to add additional SWD modules to a project-specific PROFIBUS-
DP configuration with the "HW Konfig" PLC programming environment, fol-
low the steps in the following description, ￫ Section "6.3 Select the Smart-
Wire-DT® modules“.

￫ Once you have added this modular field bus module to your S7 
project, all the configured SWD modules in the SWD line will be 
shown in the Station window detailed view.
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6.3 Select the SmartWire-DT® modules
Requirement: The SWD gateway must be present in the PROFIBUS-DP con-
figuration.

▶ Move to the Hardware Catalog and click the plus sign in front of the 
standard SWD gateway EU5C-SWD-DP (Mot) under PROFIBUS-DP -> 
Additional FIELD DEVICES -> Switching Devices.

Figure 28: EU5C-SWD-DP (Mot) gateway with SWD modules in HW config
Screenshot of a STEP 7 with courtesy from SIEMENS, Nürnberg

You can then select in the "Hardware catalog" the SWD modules that you 
require on this SWD gateway.

▶ Double-click the required SWD modules.

￫ Observe the correct order of the SWD modules in the SWD line. 
These must be configured according to their arrangement in the 
installation.
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6.4 Set device parameter of the gateway
Figure 29: Selecting the SWD modules on the EU5C-SWD-DP (Mot) gateway in HW config
Screenshot of a STEP 7 with courtesy from SIEMENS, Nürnberg

6.4 Set device parameter of the gateway
Prerequisite: The "HW Config" PLC programming environment must be open.

▶ When adding the SWD gateway set its DP properties, the station param-
eters and the DP module address.

▶ In the station window, double-click the SWD gateway as a newly added 
DP module.

In the "Properties - DP slave" dialog box that opens, start configuring the 
parameters in the "General" tab.

NOTICE

The universal module is not a valid SWD module and therefore 
must not be added to the project!

￫ If possible, do not use the addresses 1 and 2, which can be 
used for other purposes, e.g. when operating multi-CPUs.
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6.4 Set device parameter of the gateway
„General“ tab

In this tab set the relevant parameters for the PROFIBUS-DP communication

Figure 30: Setting the general properties of the DP module HW config
Screenshot of a STEP 7 with courtesy from SIEMENS, Nürnberg

▶ If required activate the response monitoring.
▶ In the "Properties - DP slave" dialog, select the "Parameter assignment" 

tab.

Figure 31: Station parameters of the SWD gateway in the HW config
Screenshot of a STEP 7 with courtesy from SIEMENS, Nürnberg

„Parameter assignment“ assignment tab

This tab is used to configure the parameters for the SWD gateway, and for 
the SWD line as a result, under "Stationsparameter" -> "Gerätespezifische 
Parameter." Table 7, page 68. 
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6.5 Set the device parameters of the SWD modules
6.5 Set the device parameters of the SWD modules
Input/output addresses

Figure 32: Input/output addresses of the SWD modules in HW config
Screenshot of a STEP 7 with courtesy from SIEMENS, Nürnberg

The address proposed by the system can be accepted directly. The preset 
address value ensures that the start address is within the process image of 
the inputs and outputs.

If required the I/O addresses can also double-clicked and modified later, pro-
viding the appropriate CPU is present.

These inputs and outputs can be addressed using the PLC's I/O image table.

Adjusting specific parameters of SmartWire-DT modules

You can parameterize the startup behavior for each SWD module. This 
defines how the gateway is to respond if an SWD module is not present. The 
standard setting is that all modules have to be available.

However, the information as to whether a module is available is also 
reported to the application via the diagnostics function so that you can imple-
ment here a specific response to the failure of an individual module 
(￫ Section "6.8 Diagnostics“on Page 52).

￫ Please refer to the manual "SmartWire-DT Modules", 
MN05006001Z-EN for the exact configuration and meaning of 
the input and output data.
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6.5 Set the device parameters of the SWD modules
Changing settings

▶ To change settings in the "HW config" PLC programming environment, 
select the SWD module you want and double-click on the corresponding 
line.

▶ In the "Properties - DP-Slave" dialog, select the "Parameter assignment" 
tab.

Double-click the SWD module to display the "Properties - DP-Slave" dialog 
field.

In the "Gerätespezifische Parameter" folder, for example, you can change the 
option "Device shall be present" to "Device may not be present" (does not 
have to be present) in the "Value" column.

Figure 33: Specific parameter assignment of the SWD modules un HW config
Screenshot of a STEP 7 with courtesy from SIEMENS, Nürnberg

You can also define in this dialog whether the SWD module can be replaced 
by a universal module M22-SWD-NOP(C). In this case set the parameter 
"Replacement by universal module“ to "allowed“.

￫ Parameter setting at this point only makes sense if the value 
"Defined for each slave" is set in the application parameters (see 
above) for the parameter "All slaves optional".
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6.6 Adding SmartWire-DT® modules later on
6.6 Adding SmartWire-DT® modules later on
If you are not sure of the final SWD topology and may wish to add SWD 
modules at a later time, adding a placeholder (empty module) in the appropri-
ate position in the SWD line is recommended. This is also useful in STEP 7 
since the HW Config tool does not allow the adding of modules between 
occupied module locations.

▶ Position the permanent SWD modules in the correct order and add the 
placeholder (reserved place for expansion) at the required position. A 
wildcard reserves a SWD module address for a module to be added 
later.

▶ Save the project and then transfer it to the PLC. Then switch the PLC to 
RUN mode.

After the DP configuration is received from the PLC, the SWD gateway 
addresses the modules automatically taking the placeholder into account.

6.7 Acyclical data communication
SWD modules such as the PKE-SWD-32 module for the electronic motor-
protective circuit-breaker also supply acyclical data in addition to the cyclical 
data. The function blocks SFB52 RDREC (read record) and SFB53 WRREC 
(write record) are used in STEP7 for reading and writing acyclical data. The 
reference to the required module is implemented with these function blocks 
via the parameters "ID" and "Index".

The input address of the SmartWire-DT module with which communication 
is to be established is set at the parameter "ID". The "Index" parameter 
addresses the V1 object. The first object is assigned number 1, the second 2 
etc. On the SWD module PKE-SWD-32, the object 1 supplies the current 
value "Irel".

￫ Refer to the STEP 7 documentation for further information on 
handling these function blocks.
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6.8 Diagnostics
6.8 Diagnostics

The system SmartWire-DT provides you with cyclic and acyclic diagnostic 
information.

6.8.1 Cyclic diagnostics information
This basic diagnostic information is coded in the normal I/O map of each 
SWD module. They provide information about whether the module partici-
pates in the normal data interchange via the SWD line. Furthermore, it is 
reported whether any current diagnostic messages are pending. These two 
information items are located in the first input byte in bit positions 4 and 6 for 
all SWD modules. They permit fast and easy assessment of the condition of 
the SWD module:

• The SWD module is present and integrated actively into the SWD line.
• The SWD module is operating fault-free.

Example

The M22-SWD-K11-LED-R function element has a red LED for illuminated 
pushbuttons and the two switch states 0 and 1. With cyclical input data of 
one byte, it contains information on switch position and diagnostic informa-
tion.

Inputs:

Byte 0:

￫ Please refer to the documentation of the PROFIBUS-DP master 
XIOC-NET-DP-M in the manual MN05002002Z-DE "XIOC signal 
modules" for basic information on the DP diagnostics.
You will find explanations there on access to the diagnostic data 
of a DP slave module.

￫ When using a Simatic S7, different system components may be 
used to evaluate the module diagnostic function. For this refer 
to the relevant documentation of the CPU or CP used.

7 6 5 4 3 2 1 0

Diagnostic data Input data

SUBST PRSNT – DIAG – – NO1 NC1
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6.8 Diagnostics
Outputs:

Byte 0:

If the evaluation of the diagnostic bit shows that there is extended diagnostic 
information, details on this can be determined by evaluation of the acyclic 
diagnostics of the PROFIBUS-DP.

In the case of the SWD module considered here the following detailed condi-
tions could be determined.

BIT designation Meaning

0 NC1 = Normally Closed 0: contact actuated
1: contact not actuated

1 NO = Normally Open 0: contact not actuated
1: contact actuated

2 Not used –

3 Not used –

4 DIAG 0: no diagnostic alarm
1: Diagnosis present

5 Not used –

6 PRSNT 0: Module not available
1: Module available

7 SUBST 0: Configured module present
1: Universal module M22-SWD-NOP(C) present

7 6 5 4 3 2 1 0

- - - - - - - Q0

BIT designation Meaning

0 Q0 Activation LED

1 Not used –

2 Not used –

3 Not used –

4 Not used –

5 Not used –

6 Not used –

7 Not used –

&Value Meaning

0x10 The contact is longer than four seconds in the middle position.

0x11 There is a short circuit in the contact.
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6.8 Diagnostics
6.8.2 Acyclic diagnostics
As could already be seen in the configuration, the SWD coupling unit with its 
modules appears as a modular DP module. This also applies to the structure 
of the diagnostic data. Profibus DP defines for modular modules a standard 
access process for diagnostic information. The diagnostics consist of stan-
dard diagnostics header (DP-V0 header), of a likewise standardized module 
status and of optionally extended diagnostic messages in the attachment 
from one or several modules that report detailed diagnostics. The terms used 
in the standard PROFIBUS are used in the following. The designation “Mod-
ule” is synonymous with a SWD module.

Standard diagnosis header

DP-V0 header structure

6.8.3 Device-specific diagnostics
The device-specific diagnosis consists of the module status block, which pro-
vides general information about the module (SWD module) as well as, if nec-
essary, extended information from SWD modules that are reporting diagno-
ses.

The module status block complies with the standard requirement of the diag-
nosis of a modular DP module from the structure standpoint.

Diagnostic data Description

DP-V0 header (6 byte) Standard diagnosis header

Module status (standard) Standard module status

first extended diagnostic alarm (optional). device-specific detailed messages

…

last extended diagnostic alarm (optional.)

Byte: &Value Explanation

1 V0 Status-1

2 V0-Status-2

3 V0-Status 3

4 DP master address

5 0x4d Eaton device identification

6 0x13 Eaton device identification
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6.8 Diagnostics
Structure of the module status block

In the first byte the module status block contains the length of the complete 
module status block, followed by the codes 0x82, 0x00, 0x00. It is therefore 
compatible with the format for the status of DP-V1.

As of the fifth byte two bit status codes per module (SWD module) follow. 
So the status of up to four SWD modules is packed into a byte. Non-used 
bits are filled out with 0s in the last byte.

6.8.4 Extended diagnosis (module related)
The extended diagnostics contain the module address of the SWD module, 
status information and one or several detailed specifications relating to error 
or diagnostic causes.

Byte: &Value Description

Module status header

1 Lx Length of the module status block

2 0x82

3 0x00

4 0x00

Module status

5  Two status bits for SWD modules 1 - 4

…  Two status bits for SWD modules 5 - 8

Lx  Two status bits for other SWD modules

2-bit status 
code

Explanation

00 A cyclic data interchange is performed with the respective SWD module.

01 A diagnostic message from the SWD module is pending.

10 Configuration error (incompatible SWD module)

11 Failure of a SWD module

￫ You can find the meaning of the specifications in the manual 
"SmartWire-DT Modules", MN05006001Z-EN.
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6.8 Diagnostics
Table 5: Structure of the extended diagnosis

Example

An SWD line is made up of nine SWD modules. If a short circuit is reported 
for an EU5E-SWD-4D4D (input/output module with overload message) SWD 
module that is the fifth module in the SWD line, the diagnostics will look as 
follows:

Byte: &Valu
e

Description

1 Ly Length of detailed status message

2 0xA1 Status Type

3 SWD module address (1 - 58) 

4 0 –

5  first detailed diagnostic alarm/status message

6  –

Ly nth detailed diagnostic alarm/status message

Abso-
lute 
byte

Byte: &Val
ue

Description

1 1 0x8 V0-Status-1

2 2 0xC V0-Status-2

3 3 0 V0-Status 3

4 4 1 DP master address

5 5 0x4D Gateway ID

6 6 0x13 Gateway ID

Module status header

7 1 0xC Length of module status

8 2 0x82 –

9 3 0x00 –

10 4 0x00 –

11 5 0x0 The SWD modules 1 to 4 do not report a diagnosis.

12 6 0x01 The SWD module 5 reports a diagnosis.

13 7 0x0 The SWD module 9 does not report a diagnosis.

Extended diagnostics E/A module

14 1 5 Length of detailed status message

15 2 0xA1 Status Type

16 3 0x5 SWD module address

17 4 0 –

18 5 0x13 Message: short-circuit/overload
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7 What you need to know about SmartWire-DT®

This chapter provides a general overview of SmartWire-DT (SWD).
For more detailed descriptions, please refer to the following manuals:

• "SmartWire-DT The System", MN05006002Z-EN
• "SmartWire-DT Modules", MN05006001Z-EN

With SmartWire-DT you can interconnect up to 99 modules very quickly in 
simple steps. Modules can consist of switchgears as well as I/O compo-
nents.

The ribbon cable with the SWD modules and all components required for 
connecting them is called the SWD line. The SWD line starts at the blade ter-
minal as a possible connection to the control relay and then ends at the bus 
termination.

Figure 34: SWD coordinator with SWD line

a SWD coordinator

b SWD module

c Bus termination

①

② ② ② ② ② ②② ③
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Wiring assignment

An 8-core connecting cable is used by SWD coordinator to feed the SWD 
modules with power and exchange data. SmartWire-DT is self-configuring 
and addresses its modules at the push of a button.

Table 6: Configuration of the SmartWire-DT ribbon cable

The power supply for SWD coordinator and the SWD modules is connected 
via the POW terminals. The 15 V power supply of the SWD modules USWD is 
generated from POW.

If you wish to use contactors, circuit-breakers or motor starters in the instal-
lation with SmartWire-DT, a 24 V DC voltage UAUX must be fed in at AUX.

Definition of terms: components - elements - modules

The SWD components consist of SWD modules and SWD elements.

SWD modules are all those SWD components that respond to a request 
from the SWD coordinator, i.e. can exchange data. They are assigned an 
SWD module address.

SWD elements are passive SWD components that do not exchange data but 
are required for operating the SmartWire-DT network. SWD elements are, 
for example, the power feeder modules, SWD cables, adapters etc. SWD 
elements are not given an SWD module address.

SWD universal module

If functions have to be retrofitted on an installation, modifications in the hard-
ware configuration and program extension are normally very labor-intensive. 
The use of a universal module enables you to initially replace the SWD mod-
ules that are required at a later time. If the installation is then extended later, 
the planned modules are then installed instead of the universal modules. In 
this way, you will be able to retain all module addresses.A detailed descrip-
tion on connecting the universal modules is provided in the "SmartWire-DT 
Modules", MN05006001Z-EN.

Meaning

+24 V DC UAUX, Contactor control voltage

Chassis 
ground

Contactor control voltage

GND for device supply voltage and data cable

Data B Data cable B

Data A Data cable A

GND for device supply voltage and data (data A, data B)

SEL Select cable for automatic addressing of the 
SmartWire-DT modules

+15 V DC USWD, Device supply voltage
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Power feeder module

The number and the types of SWD modules determine the volume of data to 
be transferred and the current consumption.

You can use power feed modules if your application has a higher power con-
sumption than the device provides, or if the cable length of the SWD line 
causes an increased voltage drop. Calculation examples are provided in the 
"SmartWire-DT The System", MN05006002Z-EN.

Power feeder modules are power supply units that are connected addition-
ally to the SmartWire-DT when there is an increased current consumption or 
increased voltage drop. Being a passive SWD element, a power feeder mod-
ule does not have a module address.

The EU5C-SWD-PF1 power feeder module feeds the 24 V DC supply voltage 
for contactors on the SWD line.

The EU5C-SWD-PF2 power feeder module feeds both the 24 V DC supply 
voltage for contactors as well as the 15 V DC supply voltage for other SWD 
modules on the SWD line.

Figure 35: Schematic layout of an SWD line with the
EU5C-SWD-PF2 power feeder module

a EU5C-SWD-DP

b EU5C-SWD-PF2

TN3TN2TN1

0 V

15 V

TNnTN5TN4

15 V

...

① ②
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7.1 Configurations
7.1 Configurations

The following different SWD configurations are possible:

1 Planned SWD configuration
Before the SWD coordinator can start running, the device must know 
which SWD modules are present and how their parameters have been 
configured. This collected information is found in the planned SWD con-
figuration. 
Depending on the field bus protocol that you will be using, you will be 
creating the planned SWD configuration in the PLC programming envi-
ronment or in SWD assist.

2 Target configuration
Pressing the "Config" configuration button on the device will make the 
system determine the actual configuration and store it as a target config-
uration in the SWD coordinator.

3 Actual configuration
By this is meant the actual physical configuration present on the SWD 
line. Every Every time SWD coordinator is started, the actual configura-
tion is determined and compared with the stored target configura-
tion.time SWD coordinator is started, the actual configuration is deter-
mined and compared with the stored target configuration.

7.2 Changing the planned SWD configuration in SWD assist
To change the configuration of the SWD line, e.g., to add a new module or 
replace an existing one, you will have to change the planned SmartWire-DT 
configuration and import the target configuration again. Proceed as described 
in ￫ Section “3.1.1 Reading of target configuration”, page 30.

Example: Changing or replacing a module on the SWD line

Module M22-SWD-K11LED-W has one changeover contact and one white 
LED. This module is to be replaced with an M22-SWD-K22LED-W module, 
which features two changeover contacts and one white LED. In order to 
change the module, you would proceed as follows:

▶ Switch the power supply off at the device.
▶ Pull the M22-SWD-K11LED-W out of the external device plug.
▶ Plug the M22-SWD-K22LED-W into the external device plug.
▶ Switch on the power supply.

The SWD LED will show a red light, indicating that, as expected, the mod-
ules on the SWD line do not match the target configuration stored on the 
device.

￫ Please note that the planned SWD configuration and the project 
configuration are not the same thing. 

While the planned SWD configuration describes the parameters 
and the layout of the modules on the SWD line, the project con-
figuration is the description for the controller as such.
60 SmartWire-DT Gateway EU5C-SWD-DP 01/13 MN120001Z-EN www.eaton.eu



7 What you need to know about SmartWire-DT®

7.2 Changing the planned SWD configuration in SWD assist
▶ Press the "Config" configuration button on the front of the device.

The device will detect all the modules currently on the SWD line and store 
them in the device as a target configuration.

The SWD LED will show a green light, as the modules on the SWD line will 
match the target configuration.

The Config LED will show a red light, as the modified target configuration will 
no longer match the planned SWD configuration. You will now have to make 
them match again by using SWD assist or the PLC programming environ-
ment.

In order to modify the planned SWD configuration in SWD assist, you would 
proceed as follows:

▶ Start SWD assist.
▶ Open the "*.swd" application file with File -> Open
▶ Switch to the Project view or turn off the Communication view by clicking 

on the "View" -> "Communication view" button.
▶ Replace the M22-SWD-K11LED-W module in the Project view. To do so, 

go to the device catalog and drag M22-SWD-K22LED-W to drop it where 
M22-SWD-K11LED-W is located on your workspace.

The SWD line will show the symbol for M22-SWD-K11LED-W instead of the 
original module.

▶ Save the changed project file „*.swd“ in the PC.
▶ In order to establish a connection to the device, first switch to the Com-

munication view by clicking on the "View" > "Communication view" but-
tons.

▶ Click on the "Connection setup" button and then on the "Online" button.

The device information in SWD assist will show that the planned SWD con-
figuration and the target configuration in the device still do not match. 
Because of this, the planned SWD configuration in SWD assist will have to 
be transferred to the device.

▶ Store the modified planned SWD configuration on the device. To do this, 
click the "Configurations 
in the device" button and then the "PC=>device" button.

The device information will show the STOP device status. 

The Config LED will show a green light. This indicates that the target config-
uration and the planned SmartWire-DT configuration match. The device can 
now run.

Device:
Project. ≠ Target config.

SWD status:
STOP
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7.3 SWD cycle time

The SWD cycle time is the time required for the cyclic exchange of data 
between the coordinator and all modules using a common data frame on the 
SWD line. 

The SWD gateway is the coordinator.

The SWD cycle time does not depend on the number of modules on the 
SWD line as much as it does on the amount of payload data that the summa-
tion frame needs to transmit. Within this context, "payload data bytes" refers 
to the number of input and output bytes of a module.

There are commonplace modules, such as switches, that transmit little pay-
load data. However, there are also modules with multiple settings and read-
out values, such as motor-protective circuit-breakers. 

To calculate the SWD cycle time, each byte is counted as 10 bits, since a 
start bit and a stop bit are required for each byte for synchronization pur-
poses. The SWD cycle time can be calculated using the following formula:

n = Number of user data bytes.

C  = Baud rate [kBit/s]

nTN = number of modules

Example:

The following values are given:

Input bytes = 13 bytes

Output bytes = 8 bytes

Modules: 9

Baud rate = 125kBit/s

n = Number of user data bytes = 21

SWD cycle time tp [ms] = 1 n · 10 bit + 2 bit · nTN + 30 bit · 10

C

SWD cycle time tp [ms] = 1 21 · 10 bit + 2 bit · 9 + 30 bit · 10 = 4.224 ms

125 kBit/s
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7.3 SWD cycle time
Figure 36: SWD cycle time based on the amount of transmitted payload data bytes

a 125 kBit/s: 1 SmartWire-DT module with n user data bytes

b 125 kBit/s: 99 SmartWire-DT module with n user data bytes

c 250 kBit/s: 1 SmartWire-DT module with n user data bytes

d 250 kBit/s: 99 SmartWire-DT module with n user data bytes

When the baud rate doubles, the SWD cycle time is cut in half. In the exam-
ple above, the SWD cycle time goes from 4,224 ms at 125 kbit/s to 2.112 ms 
at 250 kbit/s.
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7.4 Cyclical input and output data of the SWD modules

All the inputs and outputs of the SWD modules that are present are stored in 
a data storage area inside the SWD coordinator. This data storage area is 
referred to as the "process image. " The input data can have a maximum size 
of 800 bytes, while the output data can have a maximum size of 642 bytes. 
In total, the data area must not exceed 1000 bytes. The cyclic exchange of 
data between the SWD coordinator and the SWD modules takes place in a 
common data frame.The input data can consist of several bytes, depending 
on the module. This input data contains information such as switch positions 
and diagnostic information.

The modules' input and output data is available to the PLC programming 
environment. To find out more about how it can be accessed, please refer to 
￫ Chapter 5 "Take XSoft-CoDeSys-2 into operation“, page 31 and 
￫ Chapter 6 "Take STEP 7 into operation“, page 42 .

Diagnostics possibilities

The SWD coordinator can provide the following diagnostic information:

• Cyclic diagnostic information
• Extended diagnostics information

Cyclic diagnostics information

SmartWire-DT provides you with cyclical diagnostic information. This infor-
mation can be evaluated in the program and used for further control tasks.

This basic diagnostic information is coded in the normal process image of 
each SWD module. The information about whether the SWD module is 
exchanging data normally or whether diagnostic alarms are currently present 
is provided on all SWD modules in the first input byte (byte 0) at bit positions 
4 and 6.

Example of input and diagnostic data

The M22-SWD-K11-LED-R function element has a red LED for illuminated 
pushbuttons and the two switch states 0 and 1. With cyclical input data of 
one byte, it contains information on switch position and diagnostic informa-
tion.

Byte 0:

 DANGER

Persons, systems and machines may be put at risk if an N/C 
contact is misinterpreted. When using N/C contacts always 
evaluate the PRSNT and DIAG diagnostic bits of this module.

7 6 5 4 3 2 1 0

Diagnostic data Input data

SUBST PRSNT – DIAG – – NO1 NC1
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The diagnostic bits of the individual SWD modules can be looked up in the 
"SmartWire-DT Modules", MN05006001Z-EN.

Example for output data:

The M22-SWD-K11-LED-R function element has a red LED for illuminated 
pushbuttons and the two switch states 0 and 1. With cyclical output data of 
one byte, it contains information on switch position and diagnostic informa-
tion.

Byte 0:

Extended diagnostic services

If a SWD module is signaling "Diagnose," i.e., if bit 4 of input byte 0 is set to 
1, the corresponding details can be obtained by evaluating the extended diag-
nostic services.

BIT designation Meaning

0 NC1 = Normally Closed 0: contact actuated
1: contact not actuated

1 NO1 = Normally Open 0: contact not actuated
1: contact actuated

2 Not used -

3 Not used -

4 DIAG 0: no diagnostic alarm
1: Diagnostic alarm present

5 Not used -

6 PRSNT 0: module not present
1: module present

7 SUBST 0: planned module is present
1:  M22-SWD-NOP(C) universal module present

7 6 5 4 3 2 1 0

– – – – – – – Q0

BIT designation Meaning

0 Q0 Control section LED

1 Not used –

2 Not used –

3 Not used –

4 Not used –

5 Not used –

6 Not used –

7 Not used –
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If you were to determine the detailed states for an M22-SWD-K11-LED-R 
function element as an example of a SWD module, you would be able to get 
information on the following:

If there is a diagnostic alarm present for an SWD module, this means that 
there is a fault on this module. Using the SWD assist software you can dis-
play the extended diagnostic alarms to identify the faults more closely. 

Proceed as follows for SWD assist to display the extended diagnostic alarms:

▶ In SWD-Assist, switch to the Communication View by clicking on the 
"View" -> "Communication View" menu option.

▶ Connect to the SWD coordinator by clicking on the "Connection estab-
lishment" button -> "Online."

▶ In the workspace, click on the module that you want to diagnose.
▶ In the Properties field choose the "Diagnostics buffer" tab.

The table in the Properties field shows you the extended diagnostic alarms. 
The alarms are logged and displayed with a time stamp. The time stamp is 
based on the system time of your PC. The code is displayed in decimal nota-
tion. Diagnostic alarms can be categorized as follows:

• Code < 1000:
Alarm comes directly from the module; the code is the same as a fault on 
field bus systems. These fault messages are described in the "Smart-
Wire-DT module" manual. The error codes stated there are in hexadeci-
mal notation.

• Code ≧ 1000:
Alarm was generated by SWD coordinator as the SWD module can no 
longer send.

The extended diagnostic alarms are not retentive in the SWD assist.
If SWD coordinator is switched off, the diagnostics buffer is cleared.

Further information on extended diagnostics is provided in the Online Help of 
SWD assist.

For more information on how to evaluate the extended diagnostic messages 
in the PLC programming environment, please refer to ￫ Chapter 5 "Take 
XSoft-CoDeSys-2 into operation“, page 31 und ￫ Chapter 6 "Take STEP 7 
into operation“, page 42
.

&Value Meaning

0x10 The contact is longer than four seconds in the middle position.

0x11 There is a short-circuit in the contact.
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7.5 SWD device parameters

In the case of EU5C-SWD-DP, the device parameters can be configured in 
the PLC programming environment. 

A "required module" is a module for which the  „Presence of device on 
SWD“ = ""Device shall be present"  so that it is enabled.

The „All slaves optional“ and „Presence of device on SWD“ device parame-
ters define whether there is a SmartWire-DT error when the actual configura-
tion is different from the target configuration.

The "Compatible devices allowed" and "Can be replaced with universal mod-
ule" device parameters define whether there is a SmartWire-DT error when 
the target configuration is different from the planned configuration.

"Online replacement" device parameter

The „Online replacement“ device parameter makes it possible to hot swap 
SWD modules block by block. In addition, the„All slaves optional“ parameter 
must be set to „Yes“ Otherwise, the entire line will be disabled if communi-
cations with one or more SmartWire-DT modules are lost.

When „Online replacement“ is enabled, the SmartWire-DT coordinator will 
perform an automatic addressing routine if it detects any differences 
between the target configuration and the actual configuration when compar-
ing them. The comparison between the planned SmartWire-DT configuration 
and the target configuration will continue to be performed.

Examples

Remember that if „All slaves optional“ is set to „Yes“ and is enabled, the 
SWD line will continue to run even if a module on the line drops out - regard-
less of whether „Online replacement“ is enabled or disabled. 

When „Online replacement“=„not allowed“ this means that the device 
parameter is not enabled. If the module is replaced with an identical module 
while the power is off, the target configuration will have to be imported again 
after the power is turned back on. The SWD line will not start running. In 
other words, the user is required to intervene.

When „Online replacement“=„allowed“ this means that the device parame-
ter is enabled. If the module is replaced with an identical module while the 
power is off, a new target configuration will be automatically imported. If this 
imported target configuration matches the planned SmartWire-DT configura-
tion, the SWD line will start running. The SWD line will also start running if 
the new modules are compatible with the planned SmartWire-DT configura-
tion and the "Compatible devices allowed"="Yes" is enabled.

NOTICE

Hot swapping modules on the SWD line is only allowed in con-
junction with the SWD4-FFR-PF1-1 power supply module and 
SWD4-FFR-ST1-1 cable adapter SmartWire-DT components.
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7.5.1 Device paramters of the SWD gateway

Table 7: Device parameter SWD coordinator

Device parameter adjustable 
on SWD coordinator

VALUE Reaction SWD line

Baud rate SmartWire-DT 4=125  kBit/s 
5=250 kBit/s 

125 kBit/s =setpoint value

Baud rate on SWD line
Setting options:
• 4 = 125 kBit/s (setpoint value)
• 5 = 250 Kbit/s (operating system V1.10 and higher)

All slaves optional
(0 = No;
1 = Yes)

Defined for each 
slave

0=Default setting
The  device parameter on each SWD module is used to define 
whether the module is optional ￫ Section “ Presence of device 
on SWD”, page 69.

Yes All SWD modules are optional.
The SWD line can be run with any number of failed SWD modules. 
Data will be transferred to the field bus master. 

The ￫ Section “ Presence of device on SWD”, page 69 setting in 
the SWD modules will have no effect.

Compatible devices allowed
(0 = No;
1 = Yes)

No 0=Default setting
The  planned SWD modules in the SWD configuration must comply 
with the SWD modules of the stored gateway target configuration. 
If they do not, no data will be transferred to the field bus master.

Yes Data will be exchanged if the SmartWire-DT modules connected to 
the SWD line are identical to or compatible with the SmartWire-DT 
modules in the planned SmartWire-DT configuration.
If they do not, no data will be transferred to the field bus master
This is displayed via the status LED on the device.
You will find the list of devices that are compatible with one 
another in ￫ Table 30, page 106.

Delay between cyclic data 
exchange
(0 - 255ms)

At present the value cannot be changed.

Online replacement
(0 = No;
1 = Yes)

not allowed 0=Default setting;
New SWD modules on the SWD line must always be assigned an 
address by importing the target configuration.

allowed This setting enables block-by-block hot swapping for SWD 
modules without having to explicitly reconfigure them via the 
device by pressing the configuration button.

In addition, the "All slaves optional" to „Yes“ Otherwise, the entire 
line will be disabled if communications with one or more Smart-
Wire-DT modules are lost.
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7.5.2 Device parameters of SWD modules

Table 8: Device parameters of SWD modules

Device parameter 
adjustable on SWD 
module

Value Reaction SmartWire-DT

Presence of device on 
SWD

Device shall be 
present

Required SWD module
1=Setpoint value
The SWD module must be present when the system 
starts and during operation. 
A missing SWD module causes following:
• PRSNT diagnostic bit to be set to "0"
• DIAG diagnostic bit to be set to "1"
• The SWD line will not start running or will be 

stopped, as the case may be.

Note:

This device parameter will only take effect if the coordi-
nator's " „All slaves optional“ device parameter is 
disabled, i.e., if it has a value of  „Defined for each 
slave“ .

Device may not be 
present

The SWD line will keep running even if the SWD module 
is missing or defective.

Replacement by 
universal module

not allowed 0=Setpoint value
The SWD module can not be replaced by a universal 
module M22-SWD-NOP(C).

allowed The SWD module can be replaced by a universal module 
M22-SWD-NOP(C).
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7.5.3 Application cases for the effective use of the device parameters
Compatible devices allowed enabled

The system is already running and both the target configuration and the 
planned SWD configuration are stored on the SWD coordinator. The SWD 
coordinator is switched off in order to replace a defective module. As you 
don't have a replacement of the same type, you use a compatible type 
according to the table. 
When you switch the SWD coordinator back on, the actual configuration will 
be determined.The automatic configuration comparison will detect the new 
module and signal this discrepancy by showing a solid red light on the Config 
LED. You will then have to press the "Config" configuration button. After this, 
the SWD coordinator will import the new target configuration. The Smart-
Wire-DT coordinator will compare the target configuration with the planned 
SmartWire-DT configuration and detect a difference between both. The sys-
tem will then check whether the "Compatible devices permissible" option has 
been enabled.If it has, the SWD coordinator will check whether the module 
in the target configuration is really compatible with the module in the planned 
SWD configuration. If it is, there is no SmartWire-DT error and the SWD line 
will start running.

Can be replaced with universal module enabled

You've designed a system and you want to first use a universal module for a 
specific module, as the actual specific module will be installed as part of a 
later upgrade. To do this, you enable the „Replacement by universal 
modul“=„allowed“ device parameter.
This makes it possible for the module in the planned SmartWire-DT configu-
ration to be replaced by a universal module in the target configuration.Once 
you install the universal module on the de-energized SWD line, you switch on 
the SWD coordinator and press the "Config" configuration button to import 
the target configuration. The check against the planned SWD configuration 
then shows that the configurations do not match. After this, the SWD coordi-
nator checks whether the „Replacement by universal modul“= „allowed“ 
device parameter is enabled for this module. If it is, the SWD line will start 
running. 
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7.6 Faults on the SWD line

Different events can occur in conjunction with the SWD line, which require 
rectification.

Missing or faulty module

If the SWD coordinator determines that the actual configuration is missing a 
SWD module from the target configuration, the PRSNT diagnostic bit will be 
set to 0.

If the „All slaves optional“ =  „Yes“, missing modules will not trigger a 
SmartWire-DT error. The „Presence of device on“ device parameter, which 
can be set individually for each SmartWire-DT module, will not be checked in 
this case. The Config LED and the SWD LED will show a solid green light.

If the „All slaves optional“=  „No“, the „Presence of device on“ device 
parameter on the individual SmartWire-DT module will be checked. 

If the missing SmartWire-DT module is not a required SmartWire-DT module, 
the SWD line will keep running and will continue to work with the remaining 
SmartWire-DT modules. The Config LED and the SWD LED will show a solid 
green light.

If, however, the SWD module is a mandatory module, the SWD LED will 
show a flashing red light and the SWD line will not start running. The Config 
LED will show a solid green light, while the SWD LED will show a flashing 
red light.
If this error occurs during ongoing operation, e.g., because a module 
responds too late or is faulty, the SWD line will resume operation as soon as 
the error is fixed. A restart is not necessary.
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"Wrong" or faulty module

An “incorrect” module is one that SWD coordinator finds which, when deter-
mining the actual configuration, is not expected in the target configuration. 

This means that if you replace a pushbutton actuator with one of the same 
type when the SWD line is switched off, it will be identified as an “incorrect” 
module by the SWD coordinator.

An “incorrect” SWD module on the SWD line can only be found on startup 
since the replacement of an SWD module is not permitted when the device 
is switched on. The following therefore distinguishes which cases an “incor-
rect” module can occur on an SWD line after startup.

If the SWD coordinator determines that an SWD module of the actual config-
uration does not match the target configuration, it defines it as an “wrong” 
module. The DIAG diagnostic bit stays at 0.

The same response also takes place if SWD coordinator finds more modules 
on the SWD line than is stored in the target configuration.

With a "wrong" module the SWD line does not go into operation. The Config 
LED is green, the continuous light; the SWD-LED is not flashing red.

You may wish to permit the “incorrect” module, because, for example, you 
wish to replace a faulty SWD module with a new one. Perhaps you wish to 
replace an SWD module with a compatible SWD module or with a universal 
module. In that case read further in ￫ Section “ "Compatible devices per-
missible" enabled”, page 94 and ￫ Section “ Can be replaced with universal 
module enabled”, page 70.

In any case, you will have to press the "Config" configuration button. 

￫ Bear in mind that the serial number of the module is also exam-
ined for matching as well as the module type.
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7.7 LEDs on the device

The SWD-LED indicates whether the actual configuration of the SWD line 
matches the target configuration.

The Config LED is used to indicate the result of the configuration comparison 
between the stored target configuration and the planned configuration. This 
comparison takes into account all relevant device and module parameters. 

Table 9: LED SWD coordinator

LEDs on the module

Table 10: LEDs on the relevant module

LED Status Data 
exchange 
coupling unit 
PLC

SmartWire-DT off no supply voltage at POW
no target configuration present

No

Green continuous light Actual configuration = Target configuration yes

green flashing The SWD modules are being addressed and 
the actual configuration is being determined,
e.g., after switching the system on or down-
loading a planned SWD configuration with 
universal modules

No

red flashing actual configuration ≠ target configuration 
e.g., a required module is missing or
one module too many

No

Red continuous light No SWD line present
No 15 V DC device voltage present

No

Config off No planned SWD configuration is available, 
because e.g.
• Initial Commissioning or
• Program in SWD coordinator was deleted

No

Green continuous light  target configuration = defined planned SWD 
configuration

yes

Green flashing A module from the planned SWD configura-
tion has been replaced with a compatible 
module in the target and actual configura-
tions

yes

Red continuous light Target configuration ≠ defined planned SWD 
configuration

No

Changes from perma-
nent orange to red

The gateway is in firmware update mode 
when the POW LED is off. The firmware 
update mode can be left by switching on the 
supply voltage again.

No

LED Status

Module-LED off no 15 V supply voltage

green flashing Waiting for addressing

green fast flashing Error on module and diagnostic alarm is "1"

Green continuous light Module matches the target configuration.
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7.8 SWD assist
Further information is provided in the manual "SmartWire-DT The System", 
MN05006002Z-EN.

7.8 SWD assist
The SWD assist planning, ordering and commissioning program can be used 
to perform the following functions, among others:

• Selecting modules, as well as a gateway
• Entering device parameters for the SWD gateway and the

SWD modules
• Entering SWD network parameters 
• Status indication of the inputs/outputs
• Wiring test
• Reading of the stored actual configuration
• Importing the planned SWD configuration stored on the gateway
• Comparison of the target and actual configuration
• Display of cyclical and acyclical diagnostics messages

The Online Help function provides a detailed description of how to use SWD-
Assist. In order to open it, click on the "?" icon on the SWD-Assist menu bar 
or press the F1 key.
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8.1 Dimensions

EU5C-SWD-DP

Dimensions W x H x D mm 35 X 90 X 126.5 

inch 1.38 X 3.54 X 4.98

Dimensions a mm 122

inch 4.8

Space units (SU) width 2

Weight kg 0.16

lb 0.35

Mounting Considerations Top-hat rail IEC/EN 60715, 35 mm or screw fixing usingfixing brackets 
ZB4-101-GF1 (accessories).

Mounting position Horizontal or vertical

Figure 37: Dimensions EU5C-SWD-DP
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8.2.1 Standards

8.2.2 General ambient conditions

EU5C-SWD-DP

Standards EN 55011, EN 50178, EN 61131-2, IEC EN 61000-4, IEC60068-2-6, 
IEC60068-2-27

EU5C-SWD-DP

Ambient mechanical conditions

Degree of protection (IEC/EN 60529, EN50178, VBG 4) IP20

Vibrations (IEC/EN 61131-2:2008)

constant amplitude 0.15 mm Hz 5 – 8.4

constant acceleration 1 g Hz 8.4 – 150

Mechanical shock resistance (IEC/EN 60068-2-27) 
semi-sinusoidal 15 g/11 ms

Impact 
resis-
tances

9

Drop to IEC/EN 60068-2-31 Drop height mm 50

Free fall, packaged (IEC/EN 60068-2-32) m 0.3

Ambient climatic conditions

Operating ambient temperature (IEC 60068-2) °C -25 to +55

Condensation prevent with suitable measures 

Storage °C –40 to +70

Relative humidity, non-condensing (IEC/EN 60068-2-30) % 5 – 95

Electromagnetic compatibility (EMC)

Overvoltage category II

Pollution degree 2

Electrostatic discharge (IEC/EN 61131-2:2008)

 Air discharge (Level 3)  kV 8

 Contact discharge (Level 2)  kV 4

Electromagnetic fields (IEC/EN 61131-2:2008)

80 - 1000 MHz V/m 10

1.4 - 2 GHz V/m 3

2 - 2.7 GHz V/m 1

Radio interference suppression (SmartWire-DT) EN 55011 Class A

Burst (IEC/EN 61131-2:2008, Level 3)

Supply cables  kV 2

Fieldbus cable  kV 1

SmartWire-DT cables  kV 1

Surge (IEC/EN 61131-2:2008, Level 1)

Supply cables/Fieldbus cable  kV supply cable: 0.5,
bus cable: 1 

Radiated RFI (IEC/EN 61131-2:2008, Level 3) V 10
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8.2.3 Power supply

EU5C-SWD-DP

DC power supply AUX

Rated operational voltage V 24 DC -15 % +20 %

Residual ripple of input voltage % F 5

Protection against polarity reversal Yes

Maximum current Imax A_x CE:31)

UL: 21)

Short-circuit strength no,
external fuse
CE: FAZ 3
UL: FAZ 2

Heat dissipation W Normally 1

Potential isolation

from power supply POW Yes

from serial interface No

from SmartWire-DT No

from fieldbus interface Yes

Rated operating voltage of 24-V-DC modules V typical UAUX - 0.2

DC power supply POW

Supply voltage V 24 DC -15 % + 20 %

% F 5

Yes

Rated operational current Ie A_x 0.7

Overload proof yes

Inrush current and length 12.5 A/6 ms

Heat dissipation at 24 V DC W 3.8

Potential isolation between UPow and 15 V SmartWire-DT supply voltage No

Potential isolation

from power supply POW Yes

from serial interface No

from SmartWire-DT No

from fieldbus interface Yes

Bridging voltage dips ms 10

Repeat rate s 1

Status display POW-LED
plain color: orange

1) When the total power consumption > Imax , 
an EU5C-SWD-PF1 or EU5C-SWD-PF2 power feeder module has to be used.
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8.2.4 SmartWire-DT®

EU5C-SWD-DP

SmartWire-DT power supply USWD
(generated from the POW supply voltage)

Rated operational voltage Ue V 14.5 g 3 %

max. current Imax A 0,71)

Short-circuit strength Yes

Potential isolation

from power supply POW No

from power supply AUX Yes

from serial interface No

from fieldbus interface Yes

Connection supply voltages

Connection type Push in terminals

solid mm2 0.2 – 1.5 (AWG 24 – 16)

flexible with ferrule mm2 0.25 – 1.5

SmartWire-DT line

Module type SWD configurator

Max. number of SmartWire-DT modules 58 

Baud rate kBd 125/250

Interface standard of data cable RS485

Address setting automatically via configuration 
button

Status display Multi-color SWD-LED: orange/
green/red
Dual colored Config LED: green/red

Connections Plug, 8-pole

Plug connectors Blade terminal SWD4-8MF2

Bus termination resistor SWD line integrated in the device: 
the end of the SWD line must be 
terminated with
SWD-RC8-10

1) When the total power consumption > Imax ,
an EU5C-SWD-PF2 power feeder module has to be used.
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8.2 Technical data
8.2.5 Field bus interface PROFIBUS-DP

8.2.6 Diagnostics interface

EU5C-SWD-DP

Fieldbus interface

Function PROFIBUS DP slave

Default port None

Protocol PROFIBUS-DP V 1

Input data, maximum Byte 240

Output data, maximum Byte 240

Baud rate MBit up to 12 MB

Baud rate detection automatic

Address setting automatic

Module address 2 – 125

Address setting with DIP Switch

Status display interface DP-LED
two-colored: red/green

Bus termination resistor switchable via plug

Terminal types 1 x SUB-D, 9-pole, socket

Potential isolation

from power supply POW / AUX Yes

from serial interface Yes

from SmartWire-DT Yes

EU5C-SWD-DP

Diagnostics interface

Part no. RS232

Terminal types RJ45

Potential isolation

from power supply POW / AUX No

from SmartWire-DT No

from fieldbus interface Yes
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8.3 Compatible SWD module types
8.3 Compatible SWD module types

You can find permissible SWD modules and their permissible replacement 
types:

Table 11: List of types that are compatible with one another

Part no. Description permissible replace-
ment type 1

permissible replace-
ment type 2

RMQ function elements (front mount)

M22-SWD-K11 Function element, 2 pos. front M22-SWD-K22  

M22-SWD-K22 Function element, 3 pos. front  

M22-SWD-LED-W Function element, LED W front M22-SWD-K11LED-W M22-SWD-K22LED-W

M22-SWD-K11LED-W Function element, 2 pos., LED W, front M22-SWD-K22LED-W  

M22-SWD-K22LED-W Function element, 3 pos., LED W, front  

M22-SWD-LED-R Function element, LED R front M22-SWD-K11LED-R M22-SWD-K22LED-R

M22-SWD-K11LED-R Function element, 2 pos., LED R, front M22-SWD-K22LED-R  

M22-SWD-K22LED-R Function element, 3 pos., LED R, front  

M22-SWD-LED-G Function element, LED G front M22-SWD-K11LED-G M22-SWD-K22LED-G

M22-SWD-K11LED-G Function element, 2 pos., LED G, front M22-SWD-K22LED-G  

M22-SWD-K22LED-G Function element, 3 pos., LED G, front  

M22-SWD-LED-B Function element, LED B front M22-SWD-K11LED-B M22-SWD-K22LED-B

M22-SWD-K11LED-B Function element, 2 pos., LED B, front M22-SWD-K22LED-B  

M22-SWD-K22LED-B Function element, 3 pos., LED B, front  
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8.3 Compatible SWD module types
RMQ function elements (base fixing)

M22-SWD-KC11 Function element, 2 pos., base M22-SWD-KC22  

M22-SWD-KC22 Function element, 3 pos., base  

M22-SWD-LEDC-W Function element, LED-W, base M22-SWD-K11LEDC-W M22-SWD-K22LEDC-W

M22-SWD-K11LEDC-W Function element, 2 pos., LED-W, base M22-SWD-K22LEDC-W  

M22-SWD-K22LEDC-W Function element, 3 pos., LED-W, base  

M22-SWD-LEDC-R Function element, LED-R, base M22-SWD-K11LEDC-R M22-SWD-K22LEDC-R

M22-SWD-K11LEDC-R Function element, 2 pos., LED-R, base M22-SWD-K22LEDC-R  

M22-SWD-K22LEDC-R Function element, 3 pos., LED-R,, base  

M22-SWD-LEDC-G Function element, LED-G, base M22-SWD-K11LEDC-G M22-SWD-K22LEDC-G

M22-SWD-K11LEDC-G Function element, 2 pos., LED-G, base M22-SWD-K22LEDC-G  

M22-SWD-K22LEDC-G Function element, 3 pos., LED-G, base  

M22-SWD-LEDC-B Function element, LED-B, base M22-SWD-K11LEDC-B M22-SWD-K22LEDC-B

M22-SWD-K11LEDC-B Function element, 2 pos., LED-B, base M22-SWD-K22LEDC-B  

M22-SWD-K22LEDC-B Function element, 3 pos., LED-B, base  

DILM/MSC function elements

DIL-SWD-32-001 DIL/MSC DIL-SWD-32-002  

DIL-SWD-32-002 DIL/MSC, Manual/Auto  

PKE-SWD-32

I/O function elements

EU5E-SWD-4DX Digital module, 4 inputs

EU5E-SWD-8DX Digital module, 8 inputs  

EU5E-SWD-4D4D Digital module, 4 inputs, 4 outputs  

EU5E-SWD-4D2R Digital module, 4 inputs, 2 outputs

EU5E-SWD-X8D Digital module, 8 outputs

EU5E-SWD-4AX Analog module, 4 inputs

EU5E-SWD-2A2A Analog module 2 inputs, 2 outputs

EU5E-SWD-4PT Analog module, 4 temperature inputs

EU5E-SWD-4PT-2 Analog module, 4 temperature inputs

Part no. Description permissible replace-
ment type 1

permissible replace-
ment type 2
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